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Technical Support 
 

The Bynari Insight products can be purchased with one of the following technical support options in-
cluded:  
• Without Support – 90 day of free product maintenance and upgrades. 
• With Support – 1 year product maintenance, upgrades and unlimited email and telephone support.  

Available to customers from anywhere.   

To contact technical support  

Phone 1-214-350-5772 or email: support@bynari.net

For FAQs:  http://www.bynari.net/faq/

 

 

 

 

 

 

 

 

 

mailto:support@bynari.net
http://www.bynari.net/faq/
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Licensing 
This version of the Bynari Insight Connector utilizes a licensing key system that determines the number of 
licenses that have been purchased by the customer. When Outlook is started the licensing agent within 
the Insight Connector will contact the Bynari Key Server over the Internet to validate and activate the in-
stalled license. Activation will be attempted each time Outlook is started until activation of the license suc-
ceeds. 

 

A license activation may fail for the following reasons: 

 
• The client systems are blocked from accessing the Internet or Internet access is temporarily unavail-

able. 
• The license key entered during the installation of the Insight Connector is invalid. 
• The number of client licenses has been exceeded. The Bynari Key Server tracks how many client 

systems have been activated using a given license. If the number of activated clients exceeds the to-
tal for the license the Insight Connector will inform you that additional licenses should be purchased. 

• If you need to reinstall the Insight Connector software on a new system due to either hardware failure 
or system upgrade, contact Bynari’s support staff to assist you with removing the existing client’s reg-
istration.   

 

 

If you experience problems with license activation please contact your reseller or Bynari sup-
port staff as noted in the beginning of this guide. 

 

Important Notes:   

 This documentation applies to the latest build of the Insight Connector available on the  
Bynari Website. 
 
        Ensure that Outlook is setup as the default e-mail client.   To verify this on the client go to 

Control Panel > Internet Options > Programs and make sure that Outlook is selected in the 
drop down box. 

 Please note that the Insight Connector has been tested with our Insight Server only. We do not 
guarantee that any other mail servers will work with our Connector. If you are using another IMAP4 
mail server with ACL and would like assistance, we will provide our best effort support at a rate of 
$150 per hour. Thank you and enjoy.  
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Insight Connector version 3 
The Bynari Insight Connector acts as a MAPI transport provider for Microsoft Outlook.  Using the 
Insight Connector, IMAP mailboxes can now operate as full Outlook information stores containing 
any kind of Outlook items such as Appointment, Contact, and Task items instead of limiting to 
messages only. 

When Insight Connector is used in conjunction with our Linux based mail server, Insight Server, a 
powerful collaboration environment is created.  Users are able to share mail folders, contacts, 
and calendaring information with other individuals or system wide.  Public folders of each type 
can also be created and maintained by system administrators through the web admin interface.  
All of these functions are supported through the familiar Outlook interface eliminating any need 
for additional costly end user training. 

Architecture 
Messaging Application Programming Interface or MAPI has two 
major components.  Applications such as Microsoft Outlook use 
the client side interface to contact the MAPI subsystem for all 
communications with the message store.  There is also a service 
provider interface which is used by programs such as Insight 
Connector to provide the MAPI transport services for accessing 
the message store on the server. 

Insight Connector acts as a transport agent that provides messag-
ing services directly to the MAPI subsystem and stores this infor-
mation on Insight Server via the IMAP protocol. 

 

                                                                                                                                         Figure 1 - MAPI Architecture 

New Features of Insight Connector 3.0 
• Instantaneous IMAP transactions 

• Increased speed and stability 

• IMAP server now considered authoritative source 

• Connector is now the native MAPI service provider eliminating the need for the PST 

• New email notification 

• Task requests supported 

• IMAP folder subscription 

• Read Receipt support 
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Installing Insight Connector 3.0 
These steps explain how to install and configure the Insight Connector 3.0 for Microsoft Outlook. 
 

Note: The Bynari Insight Connector will only install on systems where the user has  
administrative rights. The users’ rights can be changed to install the Bynari Insight-
Connector and then reset to the original rights. 

 
1.  Verify that Microsoft Outlook is installed with all of the latest Service Packs and Critical up-

dates; if it is not, install it at this time. 
 

Note: If Outlook has not been previously installed, it is recommended that you do not 
create any user profiles at this time.  If Outlook has been installed previously and a user 
profile has been created it is recommended that you create a completely new profile. 

  
2.   Ensure that Outlook and any other unnecessary programs are closed before installing the In-

sight Connector. 
 

3.   Locate and launch the executable file for the Insight Connector installer package as shown in 
Figure 2. 

 

 
Figure 2 - Insight Connector Installer Package 
 

4.   After the setup initializes the “Welcome” dialogue box will appear, click “Next >”. 
 
5.  Read the license agreement and if you agree, check “I accept the license agreement” and 

click “Next >”. 
 
6.   The next dialogue box will ask for confirmation of the destination of the program files.  At this 

time you may choose a different location other than default, browse to the directory and se-
lect “Next >”. 

 
7.   In the next dialog choose whether you would like the Insight Connector toolbar visible or hid-

den.  It is recommended that you do not hide the toolbar. However if you do, you can always 
make it visible again. (Section titled Using Insight Connector of this document covers normal 
operations and describes how to change more settings) Click “Next >”. 

 
8.   Review configuration settings and select Install. 
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Figure 3 - Select Review Configuration settings 

 
9.  After the connector is successfully installed a final dialog will appear, click “Finish”.   The in-

stallation portion of the connector is now complete.  Now you will need to configure Outlook 
to take advantage of the Insight Connector. 

 

Outlook and Insight Connector Configuration 
   

This section describes how to configure Outlook to best use the Insight Connector. 
 
It is considered best practice to create an additional profile in Outlook when installing the Insight 
Connector.  As with any upgrade process you should also backup you existing Outlook PST to 
ensure that no data loss will be experienced due to the installation problems should they occur. 
 
When installing Insight Connector in addition to another POP3 account type you must install the 
Insight Connector account type first.  Installing a POP3 account type before the Connector will re-
sult in an error during the installation process of the Connector. 
 
While creating a profile using the steps below, Outlook will be using a wizard for most of the 
steps.  Microsoft has developed the creation of profiles to be very user friendly, so only one win-
dow (even if there are many being used) will be active.  
 
Follow the steps below for your specific version of Outlook; 

For Outlook 2000: 
1. For new installations of Outlook, double click the Outlook icon and the Add Profile Wizard will 

automatically start.  For users with existing Outlook installations, open the Microsoft mail 
properties dialogue box by right-clicking the Outlook icon on the desktop and choosing “prop-
erties” 
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2. On the Services Tab at the bottom of the windows, select the button that says “Show Pro-
files”. 

 
 
3. Now select the “Add” button. 
 
4. In the box titled Microsoft Outlook Setup Wizard, select the check box next to “Bynari Insight 

Connector 3.0:” and then click “Next”. 
 

  
Figure 4 - Adding a new e-mail account to a profile 

 
 

5. Now enter the name for your Insight Connector Profile and select Next. 
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Figure 5 – Enter profile name for Outlook Setup Wizard 

 
Outlook 2000 users should now skip ahead to the section titled:  

             “Insight Connector 3.0 Connection Properties” 



  Insight Connector Installation and Configuration Guide 

- 11 – 

Revision date: 1/31/05 

For Outlook 2002 and 2003: 
 

1. Close Outlook 
 

2. For new installations of Outlook, double click the Outlook icon and the Add Profile Wizard will 
automatically start.  For users with existing Outlook installations, open the Microsoft mail 
properties dialogue box by right-clicking the Outlook icon on the desktop and choosing “prop-
erties”. 

 
3. With the properties page open, select the “Show profiles” button. 

 
4. Select “Add…” on the Mail Profiles dialog box and you will be prompted for a profile name 

and The Microsoft Outlook Setup Wizard will now run.  
 

5. In the setup wizard select “Add new e-mail account” (Figure 6) and click “Next >”. 
 

 
Figure 6 - Adding a new e-mail account to a profile 

 
6. The next screen in the setup wizard is for choosing the new account type.  Under Server 

Type click “Additional Server Types” and then select “Next >”. 
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      Figure 7 – Additional Server Types 
 

7. In the dialog box titled “Additional Server Types” select the Bynari Insight Connector 3.0 and 
click “Next >”.  
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Insight Connector 3.0 Connection Properties 
The following sections describe the configuration settings for Insight Connector 3.0 regardless of 
the version of Outlook installed.  These properties not only define account information but also de-
termine the connection type used to contact the Insight Server over the network. 

This information should be provided by the Insight Server administrator. 

 

 
     Figure 8 - General tab properties 
 

1. Under the general tab you will find two sections User Information and Account Settings.   
a. User Information is for the name, organization, and email address.  
 
b. Account Settings provides Insight Connector with the server connection properties 

and account login information.  
 

I. Display Name determines the root folder display in Outlook’s folder view. 
 

II. Server Information provides Insight Connector with both the IMAP and SMTP 
server addresses.  This can either be the IP address or Fully Qualified Domain 
Name (FQDN) for the server.  These entries generally the IP address or name of 
the Insight Server, however this may vary depending on your environment.  If you 
are unsure about these entries contact your Systems Administrator.  
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III. Logon Information requires the user id and password for the account on the Insight 

Server. 
 

 

 
Figure 9 - Test Account Settings 

 
 

2. Once the user id and password have been configured select the “Test Account Settings” but-
ton.  Upon success the above window is displayed as shown in Figure 9.  

 
 

        
        Figure 10 - Advanced tab properties 

 
3. On the Advanced tab you will find two sections 

a. Server Port Numbers allow you to configure the port settings for both Incoming Server 
(IMAP) and Outgoing Server (SMTP) services.   
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i. Incoming Servers (IMAP) allows default port configuration used by the Insight Con-

nector for receiving email via IMAP.  This area also provides the options to enable 
Secure Sockets Layer (SSL) for the IMAP connection.  Note: Selecting the SSL op-
tion will also automatically update the port to the default 993 which is used by Insight 
Server. 

 
ii. Outgoing Server (SMTP) allows default port configuration to be used by Insight Con-

nector for sending email via SMTP.  The following three options allow the user to 
configure the exact level of security used by Insight Connector when sending email. 
 
The first option “Use secured connection” allows the Connector to send mail via the 
SMTPS protocol.  This option requires the listener to be enabled on the Insight 
Server and is the least used since the introduction of Transaction Layer Security.      
 
“Use Transaction Layer Security” (TLS) 
TLS has the features of SSL encryption of both authentication and data sequences 
while still running over SMTP.   TLS is enabled in Insight Server in the default con-
figuration making it the preferred SSL encryption method to be used by clients. 

 
“SMTP server requires Authentication” is used when sending email from a client us-
ing an IP address not specified the $mynetworks configuration parameter in the Post-
fix configuration of Insight Server.  An example of this scenario is the client connect-
ing to the server via a dial-up connection over the internet.  Generally speaking, if you 
are not running on the local network that your server is on, you will likely need to en-
able this option to send email through Insight Server.  For additional information 
please contact your Insight Server Administrator. 
 
Note: SMTP Authentication is plain text; to encrypt the user id & password authenti-
cation, enable “use Transaction Layer Security (TLS)”. 

 
iii. SMTP Authentication is most often required when sending via SMTP to Insight 

Server from an external IP address.  Enabling this parameter tells the client to au-
thenticate with the server to relay messages to external domains.  The default is to 
use the same user id and password used in retrieving email via IMAP.  Specifying a 
separate User id and password combination is also allowed. 
 
 

b. Progress Indicator Preferences allows you to configure the status indicator bar when 
sending and receiving email messages.  The default is 50 messages.  Any folder with 
less than 50 messages will not show the Insight Connector status indicator.  The thresh-
old can be changed to show the indicator for every folder with even just one message.   
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      Figure 11 Folder tab properties 

 
 

4. The Folders tab allows the user to configure the default behavior of IMAP folder subscription.  
The default of configuration of the “Folder List” being set to “Show All Folders” tells the con-
nector to automatically subscribe to all folders. 

 
In larger environments, this is not always desirable when there might be several large folders 
needed by most but not all users on a server.  Selecting “Show Only Subscribed Folders” al-
lows the user to individually select which folders they would like to see in Outlook.  This in-
cludes shared folders by other users, public folders, as well as their own folders. 

 
 
Note:  Be sure not to unsubscribe the default Outlook folders (i.e.: Calendar, Contacts, 
Deleted Items, Drafts, Journal, Sent Item, Notes, Outbox and Tasks).  When these fold-
ers are not subscribed, Outlook will automatically recreate these folders on the IMAP 
server. 
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                   Figure 12 – Messages tab properties 
 

5. The Messages tab allows the user to control the default behavior for messages. 
 

a. The first property is the check box that enables the “Download Headers Only” option.  
This option is enabled by default for performance reasons. 

 
b. Read Receipt Options allow the user to configure Insight Connector to control whether 

they are prompted on a per message basis, always sent, or never sent. 
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                   Figure 13 – About tab properties 
 

6. The About tab provides Insight Connector binary version information as well as licensing and 
registration information.  For additional information about registering the product please go to 
the section titled Registering the Insight Connector. 
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Using Insight Connector 3.0 
Insight Connector 3.0 provides Outlook with a MAPI transport service that makes connecting to 
an IMAP transparent to the end user.  The following sections describe some of additional dialogs 
introduced by the Connector such as Folder permissions as well as documenting configuration 
changes needed for features such as Free/Busy.  

Folder Refresh 

Users are able to refresh the folder listing of the Inbox by selecting the “Send/Receive” button.  
With all folders the messages list is updated when the folder is selected. 

Folder Sharing 

Insight Connector allows Outlook users to share personal or public folders with other users that 
reside on the same mail server.  Folders can include calendars, inbox, tasks, contacts, etc.  

With Outlook open 

1. Go   Folder List (Figure 14) 

 

 
            Figure 14 - Select ‘Folder List’  

2. Next, highlight the folder you would like to share (Figure 15) and select the “Folder” button on 
the Insight Connector toolbar.  
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Figure 15 - Select ‘Folder’ for the folder properties 

3. The folder permissions screen will appear as in Figure 16. 

 

 
Figure 16 - Insight Connector Folder Options screen 
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4. Click ‘add’ to add users, enter the user name, using the email id on the Bynari server. The 
user id can be found on the user admin screen of the Bynari server (Figure 17).  Now select 
the permissions for the person that will be viewing this folder.  There are 4 standard pre-
defined folder option permissions you can setup: 

 -Administrator (Full rights) 

 -Guest (Lookup, Read, Set Seen Flag rights) 

 -Power User (All rights except for ‘Administrator’). 

 -User (All rights except for ‘Create’, ‘Delete’, and ‘Administrator’) 

 
Figure 17 - Pre-defined folder permissions 

5. You can also set up customized folder permissions, by clicking the ‘Advanced’ button.  You 
will find all the Access Control List (ACL) permissions (Figure 18). 
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                                Figure - 18 Advanced Permission 

6. Put a check mark next to the permission you would like to assign to a user and click OK.  Ta-
ble 1 shows a list of all the permissions available. 

 
Note: If a user does not have 'Delete' rights, and tries to edit a shared file/contact, 
that user will receive an error upon synchronization saying he does not have de-
lete rights to that folder.  This is because when you edit a document or contact, 
the old file has to be deleted before the new one can be uploaded.  This is an 
RFC ACL standard.  

 

Table 1 Access Control List Permissions 

Permissions Description 

Lookup The user may see that the mailbox exists.  

Read  The user may read the mailbox. The user may select the mailbox, fetch 
data, perform searches, and copy messages from the mailbox.  

Insert The user may insert new messages into the mailbox 

Set Seen Flag Keep per-user seen state. The "Seen" and "Recent" flags are preserved for 
the user.  

Write The user may modify flags and keywords other than "Seen" and "Deleted" 
(which are controlled by other sets of rights).  

Post  
The user may send mail to the submission address for the mailbox. This 
right differs from the "Insert" right in that the delivery system inserts trace 
information into submitted messages.  
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Create  The user may create new sub-mailboxes of the mailbox, or delete or re-
name the current mailbox.  

Delete  The user may store the "Deleted" flag, and perform expunges.  

Administrator  The user may change the ACL on the mailbox.  

7. Repeat steps 1-6 as necessary to add other users to whom you wish to share a folder.  

8. Select OK on the Insight Connector Folder options dialog box to accept the newly defined 
permissions.   

Viewing Shared Folders 

It may be required for the user to restart Outlook to see the newly shared folders under 
‘Other Users’ as shown in Figure 19. 

 
Figure 19 - “Other Users” shared folder list 

Public folders created on InsightServer will show up under ‘Shared Folders’ in Outlook 
(Figure 20).  

  
Figure 20 -  “‘Shared Folders” public folder list 

Free/Busy Configuration 

Outlook allows users to share free/busy information from their Calendars with other users 
on their mail server. With the Microsoft Office Internet Free/Busy Service, users can pub-
lish their free/busy times to a shared Internet location. Members of the service can view 
each other's free/busy information and can help control which members have access to 
their information. 



  Insight Connector Installation and Configuration Guide 

- 24 – 

Revision date: 1/31/05 

 

To configure Free/Busy: 
 

1. Select Tools-> Options-> Calendar Options. Under Advanced options, deselect the 
When sending meeting requests over the Internet, use iCalendar format option  

 
2. Select  Free/Busy Options (Figure 21).  

 
Figure 21 - Uncheck “When sending meeting…” 

3. Enter the following information as shown in Figure 22. 

-Options: You can choose how often and for how long free/busy information are 
valid.  We recommend 2 months of Free/Busy information and 1-5 minute auto-
matic updates.  

-Publish at my location: Enter in the FTP address as well as the username and 
password, exactly as shown in Figure 22 below. 

-Search Location:  Enter in the URL for the free/busy times of the shared Inter-
net location (Figure 22).   
 
Note: Both of the above URL locations consist of the server’s IP address or 
Fully Qualified Domain Name.  For additional details please contact your In-
sight Server Administrator.  
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Figure 22 - Free/Busy Options 

4. Click “OK” on the Free/Busy options dialog box to apply the settings.  

Show / Hide Toolbar  
In Outlook you have the option to show or hide the Insight Connector toolbar initially set during 
the installation.  Change this setting by selecting from the menu bar, View > Toolbars > Insight 
Connector.  This will place a check mark next to the name to show that it is enabled. 

  
Figure 23 – Show/Hide Insight Connector Toolbar 

If you have hidden the Insight Connector toolbar at the time of installation, you can show the tool bar by 
following the above steps. 
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Registering the Insight Connector 
Insight Connector should automatically register when entering the license key as described in 
section 1.  If the product fails to register, manual validation may be required. 

Normally the license key is passed via the Internet, through port 80, to the Bynari Key Validation 
Servers.  The key is then checked, and if valid the product is registered, (You can ping 
http://register.bynari.net to check for connectivity). 

 

Note:  If the workstation resides behind a firewall and port 80 is blocked, port 3080 can 
be configured for automatic registration and validation of the license key. 

To manually validate a license key: 

1. Ensure that the License Key dialogue box is opened. This is opened during the installation or 
by clicking “About” (from the Insight Connector toolbar)  click “Register”. 

2. Ensure that you have your license key entered in the top field (as in section 1). 

 
Figure 24 - Key Support button 

3. Click the “Key Support” button (Figure 25). 

http://register.bynari.net/
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Figure 25 - Key Support button 

4. Copy and paste the contents of the dialogue box that opens into an e-mail and send 
to Bynari, Inc. Support (The e-mail address can be found at www.bynari.net). 

5. A Bynari representative will contact you as soon as possible and provide validation 
information.  Select the checkbox titled “Manually validate the key” and enter the in-
formation provided into the “Key Data” and “Authorization Code” fields (Figure 26). 

 
Figure 26 - Manually entering the information 

http://www.bynari.net/
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6. Click “OK” to complete the registration process. 
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